Creating One-Page Reports

A Strategy for Engaging Busy Readers

1. Identify the audience
   - Be specific about who you are talking to and their information priorities. The content and layout of the document should be tailored to meet the needs of this audience.

2. Identify the purpose
   - Write a purpose statement that identifies why you are creating the one pager. This will help you decide what information to include or to exclude.

3. Prioritize the information
   - Categorize the information most relevant to your audience. Then rank each category from highest to lowest priority to help inform layout of the document.

4. Choose a grid
   - Use a grid to intentionally organize elements visually for readers. Select a grid template from below or see access more pre-made grids on our website along with instructions on how to use them in PowerPoint (video).

5. Draft the layout
   - Print out your grid layout and sketch your design by hand. This will allow you to think creatively without technological barriers and will save you time.

10 Steps to Creating One-Page Reports

Download Available

More Resources: Evalu-ATE.org/OnePager
WHAT?

is a one-page report

- Single page
- Summarize key information
- Audience specific
- Engaging and accessible

WHAT?

is a one-page report

- Single page
- Summarize key information
- Audience specific
- Engaging and accessible

WHY?

a one-page report

- Single page
- Summarize key information
- Audience specific
- Engaging and accessible

MORE RESOURCES: EVALUATE.ORG/ONEPAGER
1. Identify the audience

2. Choose the purpose

3. Create a grid

4. Create an overview of each path

5. Create a personal hierarchy

6. Use simple space

7. Summarize

8. Edit feedback

9. Triple check

10. Draft the one-page report
Identify the Audience

1. Identify the audience.
2. Identify the purpose.

10 Steps to create a one-page report

Identify the Audience

1. Identify the audience.
2. Identify the purpose.

Purpose Statement:
To present an evaluative summary of what activities the project is doing and the strengths and achievements the project has made.

Purpose Statement Scope:
- Too Big
- Too Small

Identify the Audience

1. Identify the audience.
2. Identify the purpose.

Purpose Statement:
To present an evaluative summary of what activities the project is doing and the strengths and achievements the project has made.

Purpose Statement Scope:
- Too Big
- Too Small

Purpose Statement:
To present an evaluative summary of what activities the project is doing and the strengths and achievements the project has made.

Purpose Statement Scope:
- Too Big
- Too Small

Purpose Statement:
To present an evaluative summary of what activities the project is doing and the strengths and achievements the project has made.

Purpose Statement Scope:
- Too Big
- Too Small

10 Steps to create a one-page report

1. Identify the audience.
2. Identify the purpose.
3. Prioritize the information.
4. Choose a grid.
5. Draft the layout.
6. Create an intentional visual path.
7. Create a purposeful hierarchy.
8. Use white space.
10. Triple check consistency.
Seattle College in Seattle, WA is the SBST Project fiscal agent.

Additionally, SBST will provide a model for Baccalaureate of Applied Science (BAS) degree programs in Sustainable Building Science Technology (SBST).

Quality and Utility of the BAS Program

In Year One, there were 15 students in the program. This is just seven students under the 24-student goal of Year One.

In Year Two, there were 1393 individuals with six SBST students in the program in the fall and 1 that may return.

In Year Three, there were 2400 individuals, significant increase over the year two number.

Regarding veterans, there were significant recruiting efforts by project partners and staff to address the under-representation of veterans in the SBST program. It is expected to increase the number of veterans from 3 to 9 in each year. There are two scheduled returnees to the program. This is more than triple the number of veterans in the program in Year Two.

Workforce Development

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

In Year One, there were 240 individuals, significant increase over the number of students in Year Two.

In Year Two, there were 1393 individuals with six SBST students in the program in the fall and 1 that may return.

In Year Three, there were 2400 individuals, significant increase over the number of students in Year Two.

Of the 2400 individuals, 65% were women, exceeding its goals with respect to recruiting females. There were significant recruiting efforts by project partners and staff to address the under-representation of women in the BAS program.

Four hundred and twenty-five (425) students have applied for this program, which is a significant increase from Year Two's number.

The external evaluation team will contact the program in the fall and 1 that may return.

In Year Three, the program is one short of its goal of 9 in three years.

Workplace Effectiveness

Cumulatively, over the 3 years, the average persistence rate is 77%.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.

The persistence rate for the year 3 cohort in the BAS in Sustainable Building Science Technology is 77%. This is a stretch goal for the fourth year, but doable.
1. Students providing them hands-on applications

Three factors were rated closely together at the top end of the scale, with "flexibility, innovation and persistence and for their commitment to sustainable building science."

Based on review of project documentation, observation, interviews with staff and surveys of stakeholders, Cumulatively, over the 3 years, the average persistence rate is 77%. There are two scheduled returnees to the program, which is one short of its goal of 75 enrollments. The spring of 2017 to determine impact of the SBST program on their education and career goals, SBST served the students and faculty of Seattle College in Seattle, WA is the SBST Project fiscal agent.

The external evaluator designed a focus group process that was conducted to present an evaluative summary of activities the project is doing and the strengths and limitations of the project be made.

The means for each statement were calculated. All features were rated as useful. Mean scores are shown below.

| Feature                                | Poor | Fair | Average
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mission/project background</td>
<td>3.23</td>
<td>3.62</td>
<td>3.69</td>
</tr>
<tr>
<td>Enrollment goals</td>
<td>3.38</td>
<td>3.67</td>
<td>3.85</td>
</tr>
<tr>
<td>Quality of program</td>
<td>3.38</td>
<td>3.67</td>
<td>3.85</td>
</tr>
<tr>
<td>Utility of program</td>
<td>3.23</td>
<td>3.62</td>
<td>3.69</td>
</tr>
<tr>
<td>Mission/project background</td>
<td>3.23</td>
<td>3.62</td>
<td>3.69</td>
</tr>
<tr>
<td>Enrollment goals</td>
<td>3.38</td>
<td>3.67</td>
<td>3.85</td>
</tr>
<tr>
<td>Quality of program</td>
<td>3.38</td>
<td>3.67</td>
<td>3.85</td>
</tr>
<tr>
<td>Utility of program</td>
<td>3.23</td>
<td>3.62</td>
<td>3.69</td>
</tr>
</tbody>
</table>

Additionally, SBST will provide a model for Baccalaureate of Applied Science (BAS) degree programs in building management operations. It's not just the good thing to do, it's the smart thing to do. The SBST team are to be commended for their commitment to sustainable building science. It's not just the good thing to do, it's the smart thing to do.
Webinar: CREATING ONE-PAGE REPORTS

April 18, 2018

Choose a GRID 4

1. Mission/project background
2. Enrollment goals
3. Quality of program
4. Utility of program
Header
Footer

Prioritize the information

1. Choose a grid
2. Draft the layout
3. Create an intentional visual path
4. Create a purposeful hierarchy
5. Use white space
6. Get feedback
7. Triple check consistency

10 STEPS to create a one-page report
1. Identify the audience
2. Identify the purpose
3. Position the information
4. Choose a grid
5. Dash the layout

MORE RESOURCES: EVALUATE.ORG/ONEPAGER
Webinar: CREATING ONE-PAGE REPORTS

April 18, 2018

MORE RESOURCES: EVALU-ATE.ORG/ONEPAGER
1. Identify the audience
2. Identify the purpose
3. Position the information
4. Choose a grid
5. Define the layout
6. Create a consistent visual path
7. Create a purposeful hierarchy

Your eyes go here first. This is seen as most important. Use white space. Your eyes go here first. This is seen as most important. Use white space. Your eyes go here first. This is seen as most important. Use white space.
This report is based on findings from the Year 3 Evaluation Report prepared by The Allison Group. This one page report was created by Terryll Bailey at tbailey@theallisongroup.com. Any questions about the findings should be addressed to 888-328-9767 x 20 or tbailey@theallisongroup.com.

Students were presented with 20 features of the program and were asked to rate their usefulness in preparing them to be successful. All areas were rated as very useful or quite useful. Three themes emerged in the top items including:

- **TOTAL STUDENTS ENROLLED**: 15
- **FEMALE STUDENTS ENROLLED**: 12
- **VETERAN STUDENTS ENROLLED**: 9

### UTILITY OF THE PROGRAM

- **Build skills in building management**: 3.85 (Excellent)
- **Build skills in sustainable building science**: 3.77 (Excellent)
- **Develop skills in building management**: 3.92 (Excellent)

### FEEDBACK

** TEAMWORK **

- Interactions with faculty and staff: Excellent
- Other: Good

** COMMUNICATION **

- Learning about real-world applications: Good
- Other: Fair

** TECHNICAL SKILLS **

- Use white space: Excellent
- Other: Good

** BACKGROUND **

- The quality of the teachers: Good
- Other: Good

** FEEDBACK **

1. Identify the audience
2. Identify the purpose
3. Practice the information
4. Choose a grid
5. Draft the layout
6. Create an intentional visual path
7. Create a purposeful hierarchy
8. Use white space
9. Get feedback

** AWARDS: **

- **FUNDING**: *NSF*# 1600992
- **Awards Amount**: $862,080.00 (3 year grant + 1 cost extension)
- **Focus Area**: Advanced Technological Education
- **Evaluation Support Center**: Seattle Baccalaureate STEM Pathways
- **Mission**: Expand access to applied education and training.

**Yr1**

- Feedback: Excellent
- Operations: Fair

**Yr2**

- Feedback: Good
- Operations: Poor

**Yr3**

- Feedback: Excellent
- Operations: Excellent

**Yr4**

- Feedback: Good
- Operations: Fair

** ENROLLMENT GOALS **

- **Females**: 12
- **Veterans**: 9
- **Other**: 3

** FUTURE GOALS **

- **Improvement Plan**: Improve feedback processes for the Yr4.
- **Next Steps**: Continue to improve feedback processes.

**WEBSITE**: www.southseattle.edu
Webinar: CREATING ONE-PAGE REPORTS

1. Identify the audience
2. Identify the purpose
3. Maintain the information
4. Choose a grid
5. Draft the layout
6. Create an intentional visual path
7. Create a purposeful hierarchy
8. Use white space
9. Get feedback
10. Triple check consistency

1. Identify the audience
2. Identify the purpose
3. Maintain the information
4. Choose a grid
5. Draft the layout
6. Create an intentional visual path
7. Create a purposeful hierarchy
8. Use white space
9. Get feedback
10. Triple check consistency

MORE RESOURCES: EVALU-ATE.ORG/ONEPAGER
TIPS & TRICKS
for succeeding on your own

SOFTWARE

Microsoft PowerPoint

Create report in PowerPoint

Microsoft PowerPoint

Create multiple “drafts” in one file

Microsoft PowerPoint

Duplicate slide for new draft

Microsoft PowerPoint

“Duplicate Slide” for new draft

Microsoft PowerPoint

Create multiple “drafts” in one file

Microsoft Excel

Use Excel for charts and graphs

SLIDE SIZE

MORE RESOURCES: EVALU-ATE.ORG/ONEPAGER
Select the "Design" tab

Select "Slide Size" icon

Select "Custom Slide Size…"

A new window will open

Change the slide size to 7.5" x 10"

Click on the "View" tab

Check the box next to "Ruler"

Check the box next to "Guides"
ALIGN OBJECTS

First select the items you want to align.

Select items to align.

Click on the “Format” Tab.

Then click on the “Arrange” icon.

Click “Align,” then “Align Middle.”

Another great feature.

Then distribute horizontally.

SAVING TO A PDF

how do I save this
Webinar: CREATING ONE-PAGE REPORTS

April 18, 2018

Go to “Print” menu
Select “Print to PDF”
Adjust to “High Quality”

ICONS
where do you find them?

Question Break
Coming Up!

Full Evaluation Report
Accompanying One-Page Report

WE VALUE YOUR FEEDBACK

THANK YOU!
Webinar:
CREATING ONE-PAGE REPORTS

THANK YOU
Emma Perk
emma.perk@wmich.edu
@emperky
Lyssa Wilson Becho
lyssa.becho@wmich.edu
@ly_wilson

MORE RESOURCES: EVALU-ATE.ORG/ONEPAGER